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READ ME FIRST

Welcome to Take Control of Customizing Tiger, version 1.0.

Every couple of years, Apple plunges its excited users into a new
world with a major revision of Mac OS X. This time, it’s Tiger (Mac
OS X 10.4). So, what’s new in Tiger? What’s all the fuss about? This
ebook shows you, through a hands-on guided tour of the adjustments,
tweaks, and customizations you can make in the System and the
Finder. This ebook was written by Matt Neuburg, edited by Tonya
Engst, and published by TidBITS Electronic Publishing.

You can contact TidBITS Electronic Publishing by sending email to
tc-comments@tidbits.com and view the Take Control Web site and
catalog at http://www.takecontrolbooks.com/. You can read About
This Ebook to learn about the author, the publisher, and the Take
Control series. The title page contains copyright and legal info.

The price of this ebook is $5. If you want to share it with a friend,
please do so as you would with a physical book, meaning that if your
friend uses it regularly, your friend should buy a copy. The Help a
Friend button on the cover makes it easy for you to give your friend
a discount coupon.

We may offer free minor updates to this ebook. Click the Check for
Updates button on the cover to access a Web page that informs you
of any available or upcoming updates. On that page, you can also
sign up to be notified about updates via email.

WARNING! If you use Adobe Acrobat Pro version 6 or 7, make sure your Web
Capture preference is set to view Web URLs in a Web browser before
checking for updates. To do so, choose Acrobat > Preferences, switch
to the Web Capture pane, and choose In Web Browser from the Open
Web Links pop-up menu.

Onscreen Reading Tips
We carefully designed the Take Control ebooks to be read onscreen,
and although most of what you need to know is obvious, note the
following for the best possible onscreen reading experience:
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• Blue text indicates links. You can click any item in the Table of
Contents to jump to that section. Cross-references are also links,
as are URLs and email addresses.

• Work with the Bookmarks tab or drawer showing so that you can
always jump to any main topic by clicking its bookmark.

• Find more tips at http://www.takecontrolbooks.com/reading-
tips.html.

Printing Tips
Although our layout is aimed at making online reading an enjoyable
experience, we’ve made sure that printing remains a reasonable
option. Please review these tips before you print:

• Use the Check for Updates button on the cover to make sure you
have the latest version of the ebook and to verify that we don’t plan
to release a new version shortly. If you want to commit this ebook
to paper, it makes sense to print the latest possible version.

• Don’t throw out your PDF after you print! You must click the
Check for Updates button on the cover to get future updates. The
link must be accessed from the cover of your PDF.

• For a tighter layout that uses fewer pages, check your printer op-
tions for a 2-up feature that prints two pages on one piece of paper.
For instance, your Print dialog may have an unlabeled pop-up
menu that offers a Layout option; choose Layout, and then choose
2 from the Pages per Sheet pop-up menu. You may also wish to
choose Single Hairline from the Border menu.

• When printing on a color inkjet printer, to avoid using a lot of
color ink (primarily on the yellow boxes we use for tips and fig-
ures), look for an option to print entirely in black-and-white.

• In the unlikely event that Adobe Acrobat or Adobe Reader cannot
successfully print this PDF, try Preview; several readers have
solved printing problems by using Preview.

Basics
In reading this ebook, you may get stuck if you don’t know certain
basic facts or if you don’t understand Take Control syntax for things
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like working with menus or finding items in the Finder. Please note
the following:

• Path syntax: I occasionally use a path to show the location of a
file or folder in your file system. Path text is formatted in bold type.
For example, Panther stores most utilities, such as Disk Utility, in
the Utilities folder; the path to Disk Utility is /Applications/
Utilities/Disk Utility.

The slash at the start of the path tells you to start from the root
level of the disk. You will also encounter paths that begin with ~
(tilde), which is a shortcut for any user’s home directory. For
example, if a person with the user name joe wants to install fonts
that only he can access, he would install them in his ~/Library/
Fonts folder, which is just another way of writing /Users/joe/
Library/Fonts.

• Menus: When I describe choosing a command from a menu in
the menu bar, I use an abbreviated description. For example, the
abbreviated description for the menu command that creates a new
default window in the Finder is “File > New Finder Window.”

• Preferences: When I say “preference pane,” or when I speak of
“the so-and-so system preferences,” I’m referring to the System
Preferences application. To start up System Preferences, choose
System Preferences from the Apple menu (or click its icon in the
Dock, if it’s there). You access a particular preference pane by way
of its icon, or the View menu. For example, to see “the Displays
preference pane,” you would launch System Preferences and then
click the Displays icon or choose View > Displays. To see “the
Color pane of the Displays system preferences,” you would do the
same thing, and then click Color.

On the other hand, talk of preferences in relation to a particular
application has to do with the window you see when you choose
AppName > Preferences (where “AppName” is the name of the
application). So, for example, when I say, “set the Terminal to
emulate a vt100 or vt102 in its preference window,” I’m telling you
to start up Terminal and then choose Terminal > Preferences and
do something in the window that appears.
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INTRODUCTION

Perhaps on the evening of April 29, 2005, you stood in line to obtain
one of the first copies of Mac OS X version 10.4 Tiger at your local
computer store. Or perhaps you were more cautious and waited until
you felt Apple had straightened out the initial kinks inevitable in a
new operating system release. One way or another, you wound up
with a copy of Tiger. You stayed up late installing it on your Mac; then
you fell asleep exhausted. You woke up the next morning excited as a
child on Christmas. You rushed to the computer and started it up.
You gasped with amazement at the new, improved startup speed. You
gawked at the blue magnifying glass in your menu bar. You squealed
with delight as you clicked the Dashboard icon in the Dock. You used
Safari to do RSS and to save a Web archive. You inserted a table and
an auto-numbered list in a TextEdit document, and added an anno-
tation to a PDF with Preview. You looked up some dubious words in
the new Dictionary.

Now it’s the second day. You’re finished playing and want to work.
You’d like to Take Control. And, in particular, you’d like to take
control of how your computer looks and behaves. But where to start?
What, in this brave new world, is up to you? What is it that needs
customization, so that things will go smoothly henceforward?

This ebook covers these second-day-of-Tiger sorts of things. It intro-
duces you to Tiger by showing you ways you can customize your
computer—ways that were impossible in previous versions of Mac
OS X, or that might not be obvious from a casual inspection, or that
experience has shown to be worthy of your attention. Whether you’ve
upgraded from Panther or switched from Windows, whether you’re
brand new to Tiger or you just want to understand it better, this
ebook is your guide to the parts of Tiger that you can and should cus-
tomize to get the most out of it. I’m not writing for Unix hackers, so I
don’t talk about technical customizations such as causing your swap-
file partition to be different from your boot partition; the customiza-
tions pointed out here are those that Tiger wants and expects you to
perform directly in its normal interface. I do, however, point out areas
where Tiger might need a little help from third-party utilities in order
for you to work most comfortably and efficiently.

Now let’s meet Tiger and take it by the tail!
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QUICK START TO CUSTOMIZING TIGER

This ebook describes many customizations, not all of which you
need employ, and some of which will be more important to you than
others. Naturally, I think that sooner or later you should take the time
to read this ebook through from start to finish, but I also understand
that you’re eager to get working with Tiger and that you’ve a busy life,
so you might want to know what’s most important to do right now,
and come back to the rest of the book later. So, I suggest a three-stage
approach:

1. Perform right away the customizations that will immediately
improve your Desktop and interface experience.

2. Learn about the major new technologies and customizations that
are possible in Tiger, so that you can get the most out of those
technologies in your work.

3. Catch up on the remaining customizations whenever you have
time. This makes sense especially for customizations where you
can’t know what you want to do until you see over time what your
own needs and habits are.

Here, then, is an overview of how I suggest you customize and learn
about Tiger with the help of this ebook:

Do these things right away:

• Check that you installed Tiger correctly, in accordance with what
you want it to do for you; read Customize Your Installation.

• If you were already using Panther and want to proceed by focusing
on changes in Tiger, you may wish to skip out of this list and in-
stead work through What’s New in Tiger.

• Customize your Finder windows so you can navigate easily to
important areas of your hard disk; read Master the Folder/File
Hierarchy (and possibly Appendix A: Finder Window
Customization.)

• Make the keyboard easier to use, the pointer easier to see, the
screen easier to read, and lots more; read Perform Miscellaneous
Configurations.

• Make effective use of the icons at the right end of your menu bar;
read Customize Status Menus.
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Learn more about Tiger:

• Explore and configure Exposé, to help you deal with window
overload; read See the Windows You Want to See.

• Simplify your font menus and make Tiger run leaner and meaner;
read Fix Your Fonts.

• Discover Spotlight, a new searching technology, and learn to make
Smart Folders in the Finder that embody live Spotlight searches;
read Understand Spotlight.

• Find out about Dashboard, where you can get information and
make settings quickly; read Dashboard.

• Learn how a new utility lets you program your Mac without
knowing a programming language; read Understand Automator.

• Know about Unicode and how to type special characters and
symbols in Mac OS X; read Be Unicode-Savvy.

Do these things as needed and when time permits:

• Tweak keyboard shortcuts and keyboard behavior to match your
needs and habits; read Consider Application Keyboard Shortcuts.

• Find out where the remaining customizations are; read Look Up a
Configuration Location.

This is a free sample of “Take Control of Customizing Tiger.”
Click here to buy the full 100-page ebook for only $5!

http://store.eSellerate.net/s.asp?s=STR5625274989&Cmd=BUY&SKURefnum=SKU85543996828&PT=TRK-0018-SAMPLE


Page 4

WHAT’S NEW IN TIGER

For readers who are already familiar with Mac OS X 10.3 Panther,
here is a special road map for learning about what new customiza-
tions are possible with Tiger:

• Explore Spotlight, a new global metadata search technology; read
Understand Spotlight.

• Find out about the new kinds of Exposé shortcut; read Customize
Exposé triggers.

• Get acquainted with Dashboard, a new quick-interaction utility;
read Dashboard.

• Learn about a cool new way to get a word’s definition in any
application; read Set Global Keyboard Shortcuts.

• Link applications into powerful workflows without learning a
programming language; read Understand Automator.

• Discover improvements in the Font Book utility; read Fix Your
Fonts.

• Dictate exactly what other users can and can’t do on your Mac;
read Limit User Powers.

• Rearrange modifier keys without harming your keyboard; read Kill
the Caps Lock.

• Make the mouse more congenial to the left hand; read Give Your
Mouse the Finger.

• Bring Mac OS X’s dates into line with your preferred style of
calendar; read Have a Nice Date.

• Get a better view of the mouse pointer (cursor) by making it
bigger; read Grow the Pointer.

• Save space in your menu bar by shrinking the status menu for Fast
User Switching item to an icon; read Overview of Status Menus.

• Discover a powerful new technology for helping the visually
impaired; read Have the Mac Read the Interface to You.
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CUSTOMIZE YOUR INSTALLATION

If you’ve already installed Tiger, it may seem too late to speak of cus-
tomizing the installation. Nevertheless, customization of Tiger does
begin with installation. When you originally run the installer, you
pass through a series of several screens leading to the actual instal-
lation; the third or fourth screen (depending how you count)—the
one after the one where you select the destination disk—contains a
Customize button at the lower left. (The button is easy to miss; this
point in the process is rather badly designed, in my opinion.) If you
click that button, you are shown a dialog where you have a chance to
select which elements of the system should be installed.

Now, don’t panic—you don’t have to reinstall if you missed this step,
or if you customized your installation but regret the way you did it.
Regardless of how you installed, you have a working installation of
Tiger (unless something very unusual happened), and that’s all that
really matters. Also, if you want to, you can later install any additional
system element, such as the drivers for a new printer, by double-
clicking the file OptionalInstalls.mpkg; it’s at the top level of
the installation disc window (scroll down in order to see it).

NOTE If you’re installing Tiger from CDs, not from a DVD, your approach
to adding system elements after installation will be different. For
details, see the latest edition of Joe Kissell’s ebook, Take Control of
Upgrading to Tiger. It provides a more complete discussion of these
matters, and will help you master the entire installation process.
http://www.takecontrolbooks.com/tiger-upgrading.html

Let’s run through the options you’re offered when you customize your
initial installation, so you can see if there’s anything you want to
install after the fact:

• Printer drivers: You should install at least the Gimp Printer
drivers, because these let you print on just about any printer; if you
have a printer and its manufacturer appears in the list, you should
install the drivers for that manufacturer as well. You needn’t install
drivers for printers you don’t have, and it’s a good idea not to, be-
cause these can take up a lot space (1.6 GB to install all of them).
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MASTER THE FOLDER/FILE HIERARCHY

Getting work done on your computer involves using an application
(for example, to surf the Web, you might use Safari); and if the results
of that work are to persist over time, it also involves a document (for
example, to write a term paper, you might create a word processing
document, using Microsoft Word or Apple’s own Pages). Applications
and documents live somewhere on your hard disk. So, to get any work
done at all, you need to be able to locate your applications and docu-
ments. Tiger gives you several ways to locate applications and docu-
ments, and lets you customize certain aspects of the process of locat-
ing them. You will work most productively, happily, and comfortably
if you do customize them, to suit your own preferences, desires, and
ways of working. This section tells you how to do so.

How do you locate things on your hard disk? There are two main
ways, which you can think of as polar opposites of one another.
One way is through the folder hierarchy. Every file (whether it’s a
document or an application) is in a folder. Every folder is in a folder.
This series of containers—a file in a folder in a folder in a
folder—continues upward until we reach the top level, called a
volume: this is usually your hard disk, or a partition of your hard disk.
So, to reach any file or folder, you can traverse that same path in
reverse, downward: starting with a volume, you look inside a folder,
then inside a folder within that, and so forth, level by level, until you
reach the file or folder you’re after. The application on your Mac that
lets you traverse this hierarchy is the Finder. The Finder’s basic
purpose is to reflect the hierarchy of files within folders within folders
that organizes what’s on your computer.

Many of us have been using computers for so long that we take the
hierarchy for granted; but it’s still a pretty terrible mode of organiza-
tion. It works, but it isn’t how your mind works—at least, it’s not the
only way your mind works. To locate a file in a hierarchy, you must
know what it’s called and where it is; and if you’ve ever said to your-
self, “Now what on earth was that file I downloaded the other day?”
or “Where did I save that word processing document I was writing?”
you’re well aware that, often, those are exactly the things you do not
know. And even if you do know, working your way down the hier-
archy, level by level, is tedious.
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work in a non-metal Finder world, completely without toolbars and
sidebars.

NOTE Working in a non-metal Finder world, though possible, is not recom-
mended. Not only would you be robbing yourself of the advantages of
the toolbar and sidebar, but also you’d be fighting the Finder all the
time. You can hide the toolbar on a folder window, but if you open
that folder window again separately (for example, by Command-
double-clicking the folder), you will probably find that the toolbar has
returned.

So much for customizing Finder windows. Now let’s turn to another
major way of jumping directly across the hierarchy of files and
folders—Spotlight, a technology that’s new in Tiger.

Understand Spotlight
Spotlight is a technology for tracking files in terms of their features.
These features of a file are called its metadata, and they include all
sorts of information about the file: its name, its creation and modifi-
cation date, its size, its contents, and so forth. Different kinds of file
provide different kinds of metadata: for example, a word processing
file has text contents, but an image file has a two-dimensional size, a
resolution, and a color profile. Spotlight knows how to extract meta-
data from many types of file; furthermore, any application can pro-
vide metadata information about whatever types of file are special
to it, and Apple’s own applications, such as iCal, Mail, and Address
Book, already do this. An unrestricted Spotlight search embraces all
the kinds of metadata; a search on “rock” might find applications with
“rock” in their name, word processing files with “rock” in their con-
tents, iPhoto images with “rock” as a keyword, and MP3 music files
with “rock” as their genre.

NOTE As you experiment with Tiger, you’ll discover that Apple has modified
some of its applications to allow you specify certain kinds of meta-
data. For example, user comments in a file’s Get Info window in the
Finder are now called Spotlight Comments, and a TextEdit document
now has Document Properties, such as an Author (choose File >
Show Properties in TextEdit to see them). All of that is so this infor-
mation can be found through Spotlight.
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On the whole, you won’t be aware that Spotlight is present until you 
need it. After you first install Tiger, you may notice background disk 
activity, along with a subtle “throbbing” of the Spotlight menu icon, as 
Spotlight constructs an initial index of the metadata of all the files on 
your hard disk; this can take quite a long time (several hours). But 
after that, Spotlight becomes more or less invisible: the index is up-
dated live each time you save or move a file (this happens so quickly 
that you probably won’t be aware of it). Thus, whenever you do a 
Spotlight search, it is usually rapid and completely up-to-date. 

By now you’re probably chomping at the bit, eager to stop reading 
about Spotlight and to try it. Before we do that, here are some 
additional cool facts about Spotlight to get you drooling even more: 

• It’s live: If the results of a Spotlight search are open, and if the 
situation on the hard disk changes—you download some files from 
the Internet, for example—the results of the search will change 
immediately to take those changes into account. 

• It’s everywhere: When you perform a local (non-Internet) 
search in any Apple application, you’re probably using Spotlight. 
The search field in the System Preferences window, the search field 
in a Finder window, the search field in the Mail window, the search 
field in an Open or Save dialog—they’re all Spotlight. As Tiger 
matures, third-party developers will add Spotlight searching to 
their applications as well. 

• It’s persistent: A Spotlight search can be saved, and various 
Apple applications provide a way to do this. The Finder gives you 
Smart Folders (which I talk about more in a moment); Mail gives 
you Smart Mailboxes; Address Book gives you Smart Groups. Be-
cause a Spotlight search is live, any time you open a Smart Folder 
or a Smart Mailbox, it updates immediately. 
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SEE THE WINDOWS YOU WANT TO SEE

Here’s a news flash from the Department of Unintended Conse-
quences: windows are great, but they’re also a problem. As soon as
you have more than a few windows open at once, it’s clear that those
windows are like automobiles, and your monitor is like a Los Angeles
freeway: it’s overcrowded, and no matter how much you widen it, it’s
still going to be overcrowded.

To ease the window traffic on your monitor, you can take advantage
of certain devices for seeing the windows you want to see. One of
these is Exposé, which lets you switch quickly among all your open
windows (or get them all out of the way so you can see your Desktop).
Another is Dashboard, which lets certain miniature applications live
in a special window layer that’s visible only when you want to use it.
Finally, if all that isn’t enough, a third-party application might make
windows work in a more satisfactory way for you.

Exposé
Let’s start with Exposé, and in particular with an overview of how
to use each of Exposé’s three modes: All Windows, Application
Windows, and Desktop. Once you understand these three modes,
you’ll be ready to customize Exposé so that you can summon those
modes whenever you like. I assume that you have not yet customized
Exposé; the keyboard shortcuts I use to start with (and which you
might want to customize) are the Tiger defaults.

All Windows mode
Press F9 to see Exposé’s All Windows mode in action (Figure 7). It
reduces every open window of all applications to a thumbnail. (By “a
thumbnail” I mean the windows show at a size small enough, and in
such a position, that they all fit on the screen without overlapping.)
You can move from window to window by pressing the arrow keys,
and pick the one you want by pressing Return; or use the mouse, hov-
ering over a window to see its name and clicking to select it. To cancel
All Windows mode, press F9 again or press Esc (or click the Desktop).
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Dashboard
Dashboard is a special application, new in Tiger, that hosts mini-
applications called widgets. When I say that a widget is a mini-
application, I’m not kidding: a widget has just one window (without
a title bar) and no menus. It doesn’t even have standard interface
elements such as Cocoa buttons and text fields; a widget’s single
window is “painted” on the screen, in any style the developer wishes.

EXTRA FOR

EXPERTS

You don’t need to know this, but I’ll tell you anyway: behind the
scenes, widgets are based on HTML, CSS, and JavaScript. A widget
is actually more akin to a Web page than to an application.

The Dashboard application consists of a single semi-transparent win-
dow which, if present, covers everything else on the screen. If Dash-
board is in front, you can access the widgets and nothing else; other-
wise, Dashboard is out of sight and out of mind. The default way to
trigger Dashboard is to click its icon on the Dock or press F12. (On
some keyboards you might have to press Fn-F12, because F12 alone
ejects a CD.) To dismiss Dashboard, click anywhere on the screen, but
not on a widget.

Any developer can create a Dashboard widget, and you can expect to
see a spate of new widgets as Tiger matures. Meanwhile, Tiger ships
with several widgets, most of which are alternatives to existing util-
ities. For example, instead of running the Calculator or keeping a
clock in your menu bar, you can use the corresponding Dashboard
widgets to compute a sum or check the time. Other included widgets,
such as Weather and Phone Book, give you quick ways to look up
information on the Internet.

NOTE The built-in widgets are located in /Library/Widgets. As you
accumulate third-party widgets, you can add them here, or you may
want to put them in your own personal ~/Library/Widgets folder.

Think of a widget as something you consult for a moment and then
dismiss. So, for example, if you need to see the time of day before
your eyes constantly as you work, then the World Clock widget isn’t
for you. But if you need merely to glance at the time of day occasion-
ally and then return to what you were doing, the World Clock widget
should be right up your street.
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CREATE SHORTCUTS AND WORKFLOWS 

Your computer should obey your orders with a minimum of fuss. You 
should be able to launch applications, choose menu items, and even 
make applications work together, as simply as possible. Ideally the 
computer should just read your mind, but that’s still in the realm of 
science fiction. This section is about some customizations that are 
possible now, to make your computer respond more nimbly to your 
keypresses and mouse clicks. 

Consider Application Keyboard Shortcuts 
Have you ever wished that a menu item you commonly use had a key-
board shortcut? For instance, sometimes you’d like to zoom a win-
dow, meaning you want it to occupy more of the screen. You could 
click the green button in the title bar, or choose Window > Zoom from 
the menu; but why not press a keyboard shortcut, so that you can 
zoom the window without fiddling with the mouse? 

What about the situation where applications don’t adopt the same 
keyboard shortcut for the same command? Take File > Save As, which 
brings up a File Save dialog so you can save a file under a new name. 
In TextEdit, Save As is Shift-Command-S. In Safari, it’s Command-S; 
if you also use the Shift key, Safari just beeps at you. Your habits from 
one application let you down in another.  

Here’s a subtle variant on that scenario. In Mail, Shift-Command-N 
means to check for new mail. Naturally you press that combination 
of keys often. But sometimes you think you’re in Mail, but you’re 
actually in the Finder. You press Shift-Command-N, and what 
happens? You’ve created a new untitled folder. Again, your habits 
from one application have backfired in a different application. 

Or, you may tend to press the wrong keyboard shortcut. In Safari, 
how often have you accidentally pressed Command-Q (meaning, 
perhaps, to press either Command-Tab or Command-W)—quitting 
Safari, and losing the Web pages you were reading? 

Wouldn’t it be nice to straighten things out? Well, you can, and you 
should. Tiger lets you customize keyboard shortcuts for menu items 
in particular applications as well as globally for all applications. Keep 
track of your habits, and if keyboard shortcuts aren’t working the way 
you need them to, you should customize them.  
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• Apple’s way: Apple wants you to use the helper application itself
to make the setting. So, for example, you can choose your pre-
ferred email client in the preferences for Apple’s Mail, and your
preferred Web browser in the preferences for Safari. But what if
an Internet program doesn’t do this—how would you make it the
default helper application? Also, what if you want to examine all
such settings in a single central location?

• Microsoft’s way: If you have Microsoft Internet Explorer, you
can view and customize all your Internet helper applications in the
Protocol Helpers pane of Internet Explorer’s Preferences window
(choose Internet Explorer > Preferences). It feels silly modifying
system-wide settings in a Web browser’s preferences, not to men-
tion the irony of compensating for an Apple failing by using a
Microsoft application; but at least the interface is excellent.

• The third-party way: Forget Apple and Microsoft. I recommend
that you download one of three third-party utilities that let you ac-
cess your Internet Config settings directly. In fact, download them
all! They are free; life is good. One is the More Internet preference
pane; the second is Alexander Clauss’s MisFox application; the
third is Rubicode’s amazing RCDefaultApp, which lets you set the
application that opens given file extensions and file types as well.
http://www.monkeyfood.com/software/MoreInternet/
http://www.clauss-net.de/misfox/misfox.html
http://www.rubicode.com/Software/RCDefaultApp/

Understand Automator
The ultimate purpose of a computer is automation. Even when you’re
doing something as simple as editing text in a word processor, you’re
automating actions that would be terribly tedious if you had to per-
form them yourself, one at a time. (If you don’t believe me, trade your
computer in for a typewriter. Slam the carriage return at the end of
every line; remember to add extra space before every paragraph; get
all the spelling right; make a mistake and retype the whole page—no
thanks!)

Nevertheless, your computer doesn’t know in advance everything you
will want to do, and there are times when you probably find yourself
performing the same actions over and over again. Or perhaps there
are things you don’t do, because, although you know how you could
do them, the prospect would be too tedious and time-consuming. This
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is a bad state of affairs. It means that the roles have been reversed:
you, the human being, are being automated, instead of the computer.

Since the dawn of computer time, the traditional way to solve this
problem has been to write a new computer program that performs
the repetitious or tedious actions. But writing a brand new program
shouldn’t be necessary when you already have applications on your
computer that can perform the desired individual steps. The problem
is to get those applications to perform those steps themselves, rather
than your having to do it one step at a time. This is why Apple created
AppleScript, which lets you assemble a sequence of actions that your
existing applications can perform, and then set that sequence going
whenever you like.

However, AppleScript is a programming language, and many users
have an aversion to programming languages. So Apple introduced, in
Tiger, a new automation technique—an application called Automator,
which lets you, the user, assemble a series of steps (called actions)
into a single sequence (called a workflow) without doing any pro-
gramming at all. A workflow can be saved as a document, so once
you’ve created a workflow, you can open it again later and perform
the same sequence of steps, in a single move.

EXTRA FOR

EXPERTS

An application that responds to AppleScript (that is, a scriptable
application) is a good candidate to be the target of an Automator
action, and behind the scenes, the heart of an Automator action that
targets a scriptable application typically is an AppleScript script. So,
when you construct a workflow in Automator, you may well be string-
ing together a series of AppleScript scripts—except that you don’t
need to know AppleScript; the scripts are already written, and you
never see them.

Tiger comes with a number of Automator actions; these actions are
stored in /System/Library/Automator. You may also expect that
many third-party actions will be written as Tiger matures; as you ac-
quire such actions, you’ll store them in /Library/Automator or
in your own user ~/Library/Automator. It is also possible for a
third-party application to be written in such a way as to include its
own actions; in a case like that, its actions will be available in Auto-
mator, but you won’t see them as individual files.
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FIX YOUR FONTS

Font management has always been a problem on the Mac. The main
trouble is that once you have more than a few fonts, Font menus be-
come long and unwieldy. Mac OS X is no exception; plus, it’s even
harder than in previous systems to know what fonts are installed and
where they are. In Mac OS X, fonts can be in any of (at least) four
places:

• /System/Library/Fonts

• /Library/Fonts

• ~/Library/Fonts

• the Fonts folder of your Classic System Folder

TIP Here’s a little-known fact: instead of installing fonts directly in your
user ~/Library/Fonts folder, you can put them in a folder within
your user ~/Library/Fonts folder. The system will still see them.
I use this trick a lot, as a way of reminding myself why a font was in-
stalled. For example, fonts installed by Microsoft Office I keep in a
folder called InstalledByMicrosoft.

Also, Mac OS X supports an exceptionally wide range of font file for-
mats; in addition to the old-style TrueType font suitcases (which, by
the way, can’t easily be opened to see what fonts are inside them, as
they could be in Mac OS 9 and earlier), Mac OS X fonts can be True-
Type data-fork files (.dfont), Windows TrueType (.ttf and .ttc), Open-
Type, and PostScript Type 1 and Multiple Master (LWFN and sfnt).

NOTE Fonts that worked on previous systems may not work on Mac OS X!
This could be because of their file format; for example, pure bitmap
fonts are no longer supported. It could also be because of the font’s
structure; for example, fonts that used to provide special characters
such as symbols and non-English letters may not be compatible with
Mac OS X’s Unicode underpinnings, and can show up as blanks or
boxes. This is particularly frustrating when you have old documents
that depend on such fonts. The matter is complex and outside the
scope of this ebook.
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CUSTOMIZE STATUS MENUS

Status menus (also called status items, status icons, menu extras,
and menu bar extras) are the icons that appear at the right end of
your menu bar. (This area is technically called the system status bar.)
In general it is up to you which status menus appear, and you can
further customize some status menus. Status menus can be a con-
venience or a waste of valuable menu bar space, depending on your
needs, your monitor size, and what you had for breakfast. The tools
for status menu management are scattered all over your computer;
this section summarizes them.

Status Menu Removal and Rearrangement
To rearrange status menus, hold the Command key and drag a menu
icon to a different location in the menu bar. To remove a status menu,
hold the Command key and drag its icon right off the menu bar.

You can’t move or remove the Spotlight icon. That’s because it isn’t
really a status menu; it’s a system menu, like the Apple menu at the
other end of the menu bar.

Overview of Status Menus
Table 3 lists some of the major status menus that are part of Tiger,
and tells how to enable them. It’s followed by some comments on a
couple of individual status menus that deserve further exploration but
haven’t been discussed earlier in this ebook.

NOTE In Table 3, everything in the second column is a preference pane (in
System Preferences, as always in this ebook), unless explicitly noted
otherwise. As a shorthand, sub-panes are notated like menus. For
example, “Desktop & Screen Saver > Desktop” means the Desktop
pane of the Desktop & Screen Saver system preferences.

Some status menus (such as Ink) are not listed because I lack the
hardware or other necessary paraphernalia to test them.
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PERFORM MISCELLANEOUS CONFIGURATIONS

This section points out some chief miscellaneous customizations that
you should not neglect in your eagerness to get on with using Tiger.
Don’t be fooled by the fact that this section comes late in the ebook. It
comes late because it collects information that couldn’t be categorized
into an earlier section. But these customizations are not unimportant.
Indeed, many of them are crucial, allowing you to do such things as
read your screen more clearly or use your mouse more effectively—
things that are fundamental to your accomplishing anything at all
with Tiger.

Set Up Login Items
Your login items are the Mac OS X equivalent of what Mac OS 9 and
earlier systems called “startup items”—applications that launch auto-
matically. Obviously, these are typically applications that you like
to have always running. A wonderful feature of Mac OS X is that,
because of its virtual memory model and non-polling event loop
architecture, there is usually no penalty whatever for having extra
applications running.

To set up applications as login items:

1. Open the Accounts preference pane.

2. Select your user name in the list on the left, and click the Login
Items button to show the Login Items pane. (Since Mac OS X first
appeared, this pane has changed names and locations repeatedly.
First it was called Login Items, then it was called Startup Items,
now it’s called Login Items again. This is the right name for it, be-
cause these are applications that will be launched when you log in
as you—not when the computer merely powers on.)

3. Locate a desired application in the Finder and drag it from the
Finder into the Login Items list. Or, click the + (plus) button and
navigate to the application in the Open dialog.

TIP A new feature in Tiger is that you can make any application in the
Dock a login item, without using the Accounts preference pane. To
do so, choose Open at Login from the application’s Dock menu.
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LOOK UP A CONFIGURATION LOCATION

On the one hand, a systematic discussion of every pane of System
Preferences, and every option in the Finder’s Preferences window,
one by one, would bore most readers to tears. On the other hand, you
can (and should) make important customizations in these locations.
So here’s a compromise—tables that present customizations grouped
by topic. If you are unfamiliar with the many options available, or just
want to review what’s possible, the tables in the rest of this section are
for you—they list things you might like to customize and point you to
the right location for doing so.

Any categorization such as this one is arbitrary and artificial, but I do
think that these categories (originally created by Take Control editor
in chief Tonya Engst) stand a good chance of being less confusing and
easier to deal with than the way Apple scatters in various locations
configurations that clearly have to do with the same thing. The
categories are:

• Customize the Desktop and Menus

• Customize Colors

• Customize Fonts, Text, and Languages

• Customize the Interface (i.e. features of the interface appearance
not covered in the previous three categories)

• Customize Hardware Settings

• Customize Miscellaneous Settings (i.e. everything else)

TIP Having trouble finding a configuration location? Use Spotlight
(Understand Spotlight)! The interface of many preference panes is
included in the search; for example, a Spotlight search on “battery”
can lead you to the Energy Saver preference pane. (Unfortunately,
Spotlight searches do not include Help documentation or the prefer-
ences of other applications such as the Finder.)
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APPENDIX A: FINDER WINDOW CUSTOMIZATION

I have encountered (and readers have reported) some disappointing
limits to how far you can readily customize Finder windows. For ex-
ample, if you prefer list view, you can set the default Finder window
(the one that appears when you press Command-N) to be in list view;
but you cannot specify that you want every Finder window you ever
open to be in list view. Thus, if you click the Music icon in a Finder
window sidebar, you may find that the Music folder opens in icon
view, and there is no setting by which you can prevent this.

The only way to impose your desired view on every Finder window
is to do it the way Superman puts on his pants—one leg at a time. As
you open a window, if it is not in list view, you choose View > as List.
Assuming you have the necessary permissions, the window should
remember its setting from then on.

To guarantee that every window you open from now on will be in list
view, you would have to open every window of every folder on your
Mac and set it to list view! Sounds prohibitively tedious, doesn’t it?
On the other hand, this is a computer, after all, and the point of hav-
ing a computer is to make it do the tedious stuff for you. You could,
therefore, do all that work with a script, instead of doing it manually.
For example, this script sets every folder within your Home folder to
list view:

on dealWith(f)
local L, ff
tell application "Finder"

try
open f
set current view of (get Finder window 1) to list view
close f
set L to (get every folder of f)
repeat with ff in L

tell me to dealWith(ff)
end repeat

end try
end tell

end dealWith
local L, f
tell application "Finder"

close every Finder window
set L to (get every folder of (get path to home folder))
repeat with f in L

tell me to dealWith(f)
end repeat

end tell
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